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Shrnuti

Tato préace zahrnuje popis algoritmii a postuptl potiebnych k tvorbé editoru Voronoio-
vych mozaiek. Editor vytvafi mozaiky na zdkladé dvou zptsobt. Prvnim zptisobem je
konvertovani uzivatelem zadaného obrazu na mozaiku a druhym zptsobem je tvorba
mozaiky s vyuzitim grup symetrii.

V piipadé tvorby mozaiky ze vstupniho obrazku lze pouzivat mnoha rtznych na-
staveni ovliviiujicich vysledny vzhled mozaiky, tzn. nastaveni barevna, rtizné zptisoby
generovani bodti ¢i nastaveni, atd. UZivatel m4 moZznost nastavit riizné parametry vy-
stupu a tim dosdhnout poZzadovaného efektu mozaikovani.

V piipadé tvorby mozaiek s vyuzitim grup symetrii 1ze vytvaret mozaiky tapetového,
péasového a rozetového vzoru. UZivatel timto zptisobem rozmisti body na plétno editoru
a editor vypocita vysledny Voronoitv diagram. Editor opét umoZziiuje aktivni spolupréaci
a komunikaci s uZivatelem a ménit nastaveni riznych parametr.
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Kapitola 1

Uvod

Tato prace se zabyva problémem tvorby mozaiek s vyuZitim Voronoiovych diagrami.
Chtéla bych zde ukazat a popsat jednu z mnoha oblasti vyuZiti Voronoiovych diagramt
a to oblast vytvarné informatiky. V diplomové praci jsem se snazila vyuZzit poznatkt
z mnoha oblasti a vhodnym zptisobem je uspofadat a vytvofit tak funkéni program,
ktery lze vyuzivat k efektnim vystuptim.

V nésledujicim textu bude nejprve definovana historie a ptivod Voronoiova diagramu,
ale také jeho zakladni definice a pojmy potiebné k dal$im kapitoldm této prace (kapitola
dva). Ve tfeti kapitole jsou popsény zdkladni algoritmy déleni roviny pomoci Voronoiova
diagramu. V nésledujici ¢tvrté kapitole je popsadn navrh editoru, respektive zptisob vyu-
ziti jednotlivych algoritmt k tvorbé mozaiek. V kapitole pété je popsana implementace
tohoto editoru véetné komunikace jednotlivych komponent programového dila. V dalsich
dvou kapitolach je popsano uzivatelské prostfedi a prace s editorem, jenz je ilustrovana
na kréatkych obrazovych ukazkach. V pfiloze této diplomové préace je obsazeno néko-
lik ukéazek vystupti editoru Voronoiovych mozaiek. Po ¢tenéfi se pfedpoklada zakladni
znalost geometrickych algoritmfi, teorie grup a symetrii.



Kapitola 2

Voronoiovy diagramy

2.1 Historie Voronoiovych diagramt

V mnoha oblastech pfirodnich i spolecenskych véd existuje mnoho obord, které se za-
byvaji problémem ¢lenéni prostoru na oblasti. S timto problémem se miizeme napiiklad
setkat v oblasti astronomie p#i studiu struktury vesmiru, v biologii pfi zjiStovani organi-
zace vyzivy zivociSnych a rostlinnych tkani ¢i v ekologii pfi rozloZeni Zivocisnych revira,
sidlist’a ekologickych nik.

Zkoumani v téchto oblastech muiZze vést k problému spocivajicich v tom, Ze existuje
kone¢na mnoZina center, jimz je piifazena jistd ¢ast prostoru. Vysledkem je rozdéleni
prostoru na systém oblasti — bunék ¢i cel, vesmés téméf nebo tipIné vypliiujicich prostor
a majicich spole¢né nejvice své hranice. V tomto piipadé déleni nazyvame teselaci, déleni
v roviné mozaikou.

Je velmi pravdépodobné, Ze samotna koncepce Voronoiovych diagramii se v histo-
rii vyskytovala mnohem dfive, nez byla formalné prezentovana v 19. stoleti. Podobnou
strukturu, jako jsou Voronoiovy diagramy, 1ze spatfit jiz v 17. stoleti v dile René Descarta.
V dilech Le Monde de Mr Descartes, ou Le Trait de la Lumiére a Principia Philosophiae, pub-
likovanych v roce 1644, se Descartes vénuje uspofddéani a rozdéleni vesmiru. K tomuto
ucelu pouziva téchto diagramii, aby ukézal usporadani hmoty ve slune¢ni soustavé. Zde
muliZeme poprvé spatfit samotnou myslenku déleni prostoru.

Avsak jako prvni podali definici a vlastnosti této koncepce Peter Gustav Lejeune
Dirichlet (1805-1859) a Georgy Fedoseevich Voronoy (Georges Voronoi) (1868-1908), kteti
ve svych studiich pozitivni kvadratické formy pouZivali specidlni tvar Voronoiovych
diagramt. Dirichlet definoval dvou- a tfi-dimenzionalni Voronoiovy diagramy, zatimco
Voronoy obecné m-dimenziondlni pfipady. Neni urcité prekvapujici, Ze prvni piipad
pouZiti téchto diagramii se objevil v oblasti krystalografie. Vyzkum v této oblasti spada
hlavné do konce 19. a do pocatku 20. stoleti a nejvice se mu vénovali védci v Némecku a
Rusku. V této dobé se Voronoiovy diagramy objevovaly pod mnoha rtiznymi jmény jako
napfiiklad Elementérni oblasti ¢i Oblast vlivu. V obdobi, kdy se pouZzivalo Voronoiovych
diagramt v krystalografii, se za¢inaji uplatiiovat také v oblasti meteorologie pfi pocitani
praméru spddu destovych srazek v jednotlivych oblastech, ale také v geografii, sociologii,
v chemii p#i modelovani sloZitych sloucenin ¢i v kddovani.

PfestoZze vyzkum a také aplikace Voronoiovych diagramti spadd zejména do oblasti
pfirodnich véd, tak prvni pouziti této koncepce lze objevit v mapé zachycujici rozsiteni
cholery ve farnosti St. Jamese ve Westminsteru béhem roku 1845. Tato mapka ukazuje
oblasti, ve kterych se vyskytovalo iimrti cholerou. Vzdalenosti mezijednotlivymi oblastmi
nejsou méfitelné v Euklidovské metrice, nybrz v terminech vzdélenosti, které umoZzriovala
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Obréazek 2.1: Voronoitiv diagram

sit’jednotlivych ulic ve Westminsteru, coz vytvarelo zéroven sit"Voronoiovych diagram,
tedy pojmu, jenz témeéf pred 150 lety nikdo neznal. Mapa se stala ,nejslavnéjsi mapou

nemoci” celého 19. stoleti. Byla velmi citovana a reprodukovana v mnoha odbornych
textech kartograft a epidemiologt.

2.2 Definice a zdkladni vlastnosti Voronoiovych diagram

Matematicky pojem Voronoiova diagramu lze ilustrovat na nasledujicim p¥ikladu: Pfed-
stavte si Petriho misku, ve které se péstuji rizné druhy barevnych bakterii, z nichZ kazda
ma na pocatku své pevné misto, kam byla umisténa. Kazd4a bakterie tedy zaujima své
misto v misce. V dalsi fazi zacne kaZzda bakterie nartistat a zvétSovat tak oblast ji pfilehlou
v konstantni rychlosti. AZ dojde k tomu, Ze se setkaji dvé rtizné barvy v misté, které je
ve stejné vzdélenosti od obou bakterii rizné barvy, potom je jejich rtist zastaven. Tento
proces bude probihat tak dlouho, aZ bude cela miska rozdélena na regiony rtiznych barev.

Misto bakterii, které se umistuji na urc¢ité misto v misce, mtiZeme vytvofit Voro-
noitv diagram s kone¢nou mnozinou bodud v roviné. Necht'tedy P = {p1,p2,...,pn}
je mnoZzina bodt, jimz se fika generdtory. Definujeme Voronoiiiv diagram jako soubor
V = {V1,Va,...,V,} podmnozin roviny, nazyvanych Voronoiovy regiony. Kazdy V; je
regionem roviny, jenZ obsahuje vsechny body leZici blize bodu p; nez k ostatnim ¢lentim
P.

Formalné maZeme Voronoitiv diagram v roviné definovat takto [1] :

Definice 1. Necht' P = {p1,p2,...,pn} CR?* kde2 < n < ccap; # p; proi # j,i,j € L.
Nazveme region dany

Vi) ={z | llz —pill <[l —pjll proj#i,j € In}

rovinnym Voronoiovym regionem asociovanym s p; (nebo také Voronoitiv polygon bodu p;)
a mnoZzinu danou

V={V(p1),V(p2),---,V(pn)}
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Obréazek 2.2: Voronoitiv diagram tvofeny priinikem polorovin

nazveme rovinnym Voronoiovym diagramem generovanym mnozinou P (nebo Voronoio-
vym diagramem mnoziny P). Body p; z vyrazu V (p;) nazveme generdtory i-tého Vorono-
iova polygonu a mnozinu P = {p1,p2, ..., p,} nazveme mnoZinou generdtorii Voronoiova
diagramu V.

Hranice Voronoiova diagramu mohou tvofit tisecky, polopfimky ¢&i pfimky, nazveme
je Voronoiovymi hranami (oznaceni e;). Sjednocenim Voronoiovych hran dostaneme sit,
kterou budeme nazyvat Voronoiovou siti. Vrcholu Voronoiovy hrany fikame Voronoitiv
vrchol.

Pro jednoduchost zavedeme oznaceni VD pro pojem Voronoiova diagramu a toto
znaceni budeme dale v textu pouZivat.

Obrazek 2.1 ukazuje pfiklad rovinného VD. Body jsou generatory, tisecky a polo-
pfimky tvofi Voronoiovy hrany. Voronoitiv region asociovany s generatory je vnitfek
polygonu obklopujici generator.

V definici 1 je VD tvofen polygony. JelikoZ polygony jsou tvofeny pomoci poloro-
vin, miZeme si zavést také alternativni definici VD, jeZ vyuZziva vlastnosti polorovin.
Abychom mohli ukazat tuto alternativni definici, uvazujeme ptlici pfimku, jenz je kolma
k tsecce p;, p; spojujici generatory p; a p;. Tuto pfimku nazveme osou mezi body p; a p;.
Osa déli rovinu na dvé poloroviny, dostaneme

H(pi,pj) = {z | |z = pill < lle—pjll} j # i

Region H (p;, p;) pojmenujeme dominantni region p; nad p;. V obrazku 2.2 vidime domi-
nantni regiony p; nad ps, ps a p4 zndzornény horizontalnim, diagondlnim a vertikalnim
Srafovanim. V tomto piipadé vytvaii pranik polorovin H (p1,p2) N H(p1,p3) N H(p1, pa)
Voronoitiv polygon asociovany s p;. Z tohoto piikladu vidime, Ze nésledujici definice je
alternativou definice 1 [1].
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Definice 2. Necht' P = {p1,p2,...,p,} CR% kde2 <n < coap; # pj proi # j,i,j € I,.
Nazveme region dany
Vip)= () Hpip))
jeln_{i}
Voronoiiiv polygon asociovany s p; a mnozinu V = {V(p1), V(p2), ..., V(pn) } rovinny Voro-
noiiiv diagram generovany P.



Kapitola 3

Algoritmy pro vytvafeni Voronoiovych diagramu

V této kapitole si ukaZeme nékteré metody tvorby Voronoiovych diagramii. Déle popsané
metody jsou zde pouze nastinéné, aby si ¢tenaf mohl udélat pfedstavu, jakym zptisobem
se Voronoiovy diagramy konstruuji. Pfesnéjsi definice 1ze nalézt napfiklad v [1].

Tyto algoritmy jsou zaloZené na déleni roviny (teselaci) dle urcitych piistupti a pravi-
del. Pfi dalSich ttvahdch budeme pfedpokladat splnéni nasledujicich pfedpokladi.

e Numerické vypocty jsou piesné (neuvazujeme omezeni dand konec¢nou délkou
reprezentace realnych ¢isel v poécitaci).

e Zadné ctyfi generatory neleZi na spole¢né kruZnici.

Nejjednodussi (pfirozena) metoda konstrukce vychézi pfimo z jeji definice, (viz. defi-
nice 2).

Algoritmus 1. NAIVNI ALGORITMUS
Vstup:  n generator(i pi,p2,...,pn
Vystup: VD mnoziny P

1. Mé&me n generatort py,pa,...,pn € P.
2. Prokazdéi € {1,2,...,n} vytvofime n — 1 polorovin H (p;,p;), 1 < j <mn,j #i
3. Prtinikem polorovin H(p;, p;),1 < j < n,j # i je burika teselace V (p;).

Tato metoda je intuitivni, ale nevhodna pro algoritmizaci. Pocet polorovin a tedy i
as vypoctu roste s n? a navic vypocet priniku velkého poétu polorovin neni trivialni
zéleZzitost. Proto se tato metoda v praxi nepouziva a davé se pfednost metodam rychlejsim

V2

a algoritmicky jednodussim.

3.1 Délici algoritmus

Tento algoritmus (v angli¢tiné zvany ,,divide-and-conquer”) vychazi z myslenky, které je
zakladem mnoha efektivnich algoritmt. Princip spo¢iva v rekurzivnim déleni problému
na mensi snadnéji feSitelné ¢asti. V tomto piipadé se vyuziva toho, Ze sestrojit VD pro
trojici generatort je trividlni problém. Rozdéleni tvoii osy stran trojihelnika, jehoZz vr-
choly lezi v generatorech. Konec¢né feSeni je slouc¢enim jednotlivych rozdéleni podmnoZin.
Postup je nasledujici [3]
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Algoritmus 2. DELICT ALGORITMUS
Vstup:  n generator(i pi,p2,...,pn
Vystup: VD mnoZiny P

1. Generétory p1,p2, ..., p, usporadejme podle rostouci x-ové souradnice.

2. Je-li n < 3 sestrojme teselaci ze dvou nebo tfi generator(i a pokracujme bodem 4.
Je-li n > 3 pokra¢ujme bodem 3.

3. Necht't je cela ¢ast §. Rozdélme P na Pr, = (p1,p2,...,pt) @ PR = (Pt41,-- -, Pn)-
Obé teselace feSme oddélené od bodu 2.

4. Spojme teselace generované P, a Pr. Pfi spojovéni dil¢ich teselaci vyuZzivame sku-
te¢nosti, Ze nové vzniklé vrcholy (na hranici mezi teselacemi) leZi na hranach jdou-
cich z néjakého uzlu do nekonecna.

3.2 ,Plane sweep” algoritmus

Metoda pohyblivé piimky (line sweep method) je obecnd metoda pouZzivand pii fe-
Seni rovinnych problémii. Dvou-dimenzionalni problém se pfevede na problém jedno-
dimenzionalni. Metoda spotiva v pouziti procesavaci piimky, které je bud’ vertikalni ¢i
horizontalni. S touto pfimkou prochazime rovinu bud’ zleva doprava nebo shora dolt.
Postupné zasahuje objekty v roviné a vzdy, kdyz dojde k takové udalosti, je vyfeSen
problém protinajici tuto piimku.

Jednoduché aplikaci metody pfi konstrukci teselaci brani skutecnost, Ze pohybliva
pfimka musi pfi konstrukci vrchol a hran vzit v Gvahu i generatory, které lezi pred
ni. Tento problém se fes$i transformaci soufadnic generatorti, kterd vsak vede k tomu,
Ze hrany teselaci jsou ¢astmi hyperbol. ProtoZe je tato metoda implementacné narocné,
pouziva se ziidka.

3.3 Inkrementdlni algoritmus

Tento algoritmus patii mezi nejpouzivanéjsi pro svou jednoduchost a ¢asovou nenaroc-
nost vypoctu. Metoda zac¢ind s jednoduchou Voronoiovou teselaci vytvofenou nékolika
generatory. Pro vytvofeni Voronoiova diagramu v roviné pouZijeme na zacatku 3 gene-
ratory. Tato teselace se pak postupné modifikuje pfidavanim dalSich generatort. Hlavni
¢ast algoritmu tedy spociva v transformaci teselace z i — 1 na ¢ generédtord pro kazdé
i€ {4,5,...,n}.



Kapitola 4

Navrh editoru

V této kapitole bych chtéla vysvétlit obecné zaklady celého Voronoiova editoru. To zna-
mend, na jakém principu je editor zaloZen, z ¢eho vychézi jednotlivé funkce v ném
implementované a shrnout celkovy ndvrh programu.

Samotny Voronoitv editor je v soucasné podobé zaméfen na dvé oblasti tvorby mo-
zaiek s vyuzitim Voronoiovych diagramu. Jednou z oblasti, na kterou se editor Voronoio-
vych mozaiek zaméfuje, je oblast ornamentélnich mozaiek, vzniklych z aplikaci symetrii.
V této oblasti je tvofivost ponechéna zcela na uZivateli, ktery sim rozhoduje jak bude cel-
kova mozaika vypadat. Druhou oblasti, kterou editor pokryvé, jsou mozaiky vzniklé ze
vstupniho obrazku. Na vstupu je tedy uZivatelem zadany obrazek, na vystupu je mozaika
tvofend timto obrazkem. Jedna se tedy o efekt mozaikovani. V dalsi ¢asti této kapitoly se
tedy zminim o principech, které mi umoZznily cely editor vytvofit.

4.1 Symetrie a Voronoiovy diagramy

V této casti kapitoly si vysvétlime, jakym zptisobem je mozné vytvaret ornamentalni
mozaiky z Voronoiovych diagramt. K této tvorbé 1ze pouZit grup symetrii a izometrii.

Izometrie jsou transformace, které zachovévaji vzdalenost. Existuji ¢tyfi druhy rovin-
nych izometrif [10]. Tvoii je translace, rotace, reflexe a klouzava reflexe.

e Translace je nejcastéjsi zptisob izometrie. Jednd se o posun objektu po pfimce na
nové misto. Jak je naznaceno v obrézku 4.1 a), objekt se po pfimce posunuje o stale
stejné velky vektor u. Zakladni vlastnosti translace je, Ze nema pevny bod, tzn.
Ze Zzadny bod nezlistane na svém misté. Orientace objektu je v pfipadé translace
zachovana.

¢ Rotace je typem izometrie, kterd také zachovava orientaci objektu. Jedna se o rotaci
objektu kolem urcitého sttedu o néjaky thel . Rotace mé tedy jeden pevny bod,
kterym je stfed, kolem néhoZ objekt rotujeme.

o Reflexe je také nazyvana zrcadlenim okolo osy. Jedna se o pieklopeni objektu okolo
osy, bud’ ve vertikalnim nebo v horizontalnim sméru. Pevnych bodt je tedy neko-
ne¢né mnoho a vSechny leZi na ose reflexe. Tato izometrie pfevraci orientaci objektu.

e Klouzava reflexe objekt posune v urcitém sméru a potom jej preklopi. Objekt se
tedy posunuje po pfimce po stale stejné velkych tisecich (@) a zaroven stiidavé méni

7z vz

orientaci. Pevny bod zde stejné jako u translace neni Zadny.
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Obrazek 4.1: a) translace b) rotace c) reflexe d) klouzava reflexe

Obrazek 4.1 ukazuje ¢tyfi zdkladni izometrie.

Symetrie je také mozné kombinovat a vytvéfet tak kompozice dvou izometrii. Tato

kompozice je opét izometrii. MnoZiny symetrii s urcitou strukturou vytvareji grupy sy-
metrii. Tyto grupy vytvareji nékolik zakladnich vzort. Témito vzory jsou tapety, vlysy a
rozety. Stru¢né si popiSeme tyto jednotlivé vzory [6].

e Tapetovy vzor (Wallpaper) se objevuje v oblasti mozaiek nej¢astéji. Pro tento vzor

(nekonecné pole) plati ndsledujici tvrzeni: Existuji takové linearné nezavislé vektory
4,0, Ze mnozina {T'(k -4 +1-0)}, Vk,l € Z , kde T znadi translaci, je mnoZzinou v8ech
posunuti vzoru.

Opakovani vzoru se tedy déje posunem transla¢ni jednotky v urc¢itém sméru. Tyto
translace tak vytvareji m¥izky 2D mozaiky. Miizky bychom mohli klasifikovat do
5 zakladnich druhti. Translace mtiZze tedy probihat v mfiZce rovnobéZnikové, pra-
vouhlé, kosoctverecné, ¢tvercové a hexagonalni, jak ukazuje obrazek 4.2 Existuje
celkem 17 zakladnich grup symetrii tapetového typu. Tyto typy grup symetrii se od

Vv

sebe odlisuji typem zakladni m#izky, fddem rotaci a reflexi okolo osy.
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Obréazek 4.2: Zakladni m¥izky tapetového vzoru

e Vlysovy vzor (Frieze) je nekone¢nym pruhem. Plati pro néj: Existuje takovy vektor
4, ze mnozina {T'(k - 4)}, Vk € Z, kde T oznacuje translaci, je mnozinou v$ech
posunuti vzoru.

Pro vlysové vzory existuje celkem 7 grup symetrii, v nichZ dochédzi k posunu
transla¢niho razitka v pasu. PouZziva rtizné ¥ady rotaci a reflexi okolo osy.

¢ Rozetovy vzor (Rosette) je také nazyvan solitér. Pro tento vzor plati: Existuje takovy
thel «, Ze mnozina {R(k - o)}, Yk € Z, kde R oznacuje rotaci, je mnozinou vsech
otoceni vzoru. Rozetovy vzor zahrnuje celkem 11 rtiznych druht symetrii. Zde
nedochazi k translacim, ale pouZivé se rotaci a reflexi.

4.1.1 Ornamentalni mozaiky tvofené Voronoiovym diagramem

Vlastnosti grup symetrie a tapetovych, vlysovych a rozetovych vzort, zminénych v pfed-
chozi ¢asti kapitoly, 1ze vyuZit také v oblasti tvorby Voronoiovych diagramii. Pokud tedy
zname algoritmy pro tvorbu Voronoiovych diagramfi, vlastnosti grup symetrii a jedno-
tlivych vzor(i, mtZeme tyto poznatky vhodné zkombinovat a vytvofit tak zajimavé mo-
zaiky tvofené Voronoiovym diagramem. V této ¢asti kapitoly si tedy vysvétlime, na jakém
principu je zaloZena kombinace znalosti Voronoiovych diagramt a grup symetrii, jaka
pravidla je pfi jejich tvorbé potfeba dodrzovat [9].

Uvazujeme, Ze mame mnoZinu generdtorti P, ze které chceme vytvofit zajimavy a
symetricky Voronoitiv diagram.

Vysledny Voronoitiv diagram mnoZiny generatort P nezavisi na pozici a orientaci
generatord v roving, ale na jejich vzdjemném uspofadani [4]. V pfipadé, Ze mame defi-
novanou shodnou transformaci (rigid motion),viz. obrazek 4.3, coz je transformace, ktera
se sklada z rotaci a posunti a zachovava vzajemné rozmisténi generatorti , neni rozdil
v tom, zda nejprve aplikujeme transformaci na generatory mnoziny P a potom spocitdme
Voronoitiv diagram této mnoziny nebo zda naopak aplikujeme transformaci na Voro-
noittv diagram, vytvoreny z ptivodniho uspofddani generatort mnoziny P. Vysledek je
naprosto identicky. Necht' tedy 7" zna¢i shodnou transformaci, potom miizeme stru¢né
vyjadfit tento vztah T'(V(P)) = V(T'(P)).

V pfipadé, Ze shodné transformace 1" v roviné zobrazuje generatory na samy sebe,
mluvime o symetrii. Jestlize ® je symetrie mnoziny generatorti P, ®(P) je opét P. Z toho
vyplyva, ze V(®(P)) = V(P). Protoze je symetrie ® specialnim pfipadem shodné trans-
formace, plati V(®(P)) = ®(V(P)). Jelikoz plati vztah V(®(P)) = V(P), lze ¥ict, ze
®(V(P)) = V(P). Tzn. symetrie mnoziny generatorti P je symetrii jejtho Voronoiova
diagramu. Ve zkratce shrneme tedy néasledujici vztahy.

11
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Obrézek 4.3: Shodn4 transformace

T(V(P)) = V(T(P)) T jeshodna transformace
o(P) P ® je symetrie

V(®(P)) = V(P) Plyne z pfedchozich dvou

V(®(P)) ®(V(P)) @ jeshodnd transformace

o(V(P)) = V(P)

Z téchto jednoduchych vztahti vyplyva, Ze pokud médme symetricky uspofaddané ge-
neratory mnoziny P, bude také jejich Voronoitiv diagram symetricky. Na obrazku 4.4 je
ptiklad generatorti mnoziny P uspofadanych do tapety, rozety a pasu.

Rozmisténi bodit mnoZiny P v roviné ovliviiuji také vyznamné dva parametry, které
jsou na sobé vzijemné zavislé.

e Prvnim z nich je parametr Density, tedy hustota bodt v daném vzoru. Tento pa-
rametr pfimo ovliviiuje velikost vektoru @ pfi translaci a klouzavé reflexi. Pfi jeho
velké hodnoté bude mit vektor posunu % malou hodnotu a dlazdice tvofena sou-
stavou nékolika Voronoiovych generétorti se bude opakovat castéji nez pfi volbé
mensi hodnoty parametru.

e Druhy parametr Jitter, do ¢eStiny téZ pfekladan jako ,roztfeseni”, vnasi do celko-
vého vzhledu urc¢itou miru ndhody. Diagram tedy neni tak pravidelny a symetricky.
Pokud je tedy urcena kone¢nd pozice bodt v roving, tak jesté pred jejich vykres-
lenfm na obrazovku se k této pozici pficte néjaké nahodné ¢islo ve sméru x-ové a
y—ové osy. Vysledné umisténi bodu je tedy ponékud ,roztfesené” a do kone¢ného
Voronoiova diagramu je tak vnesena nepravidelnost. Nahodné ¢islo, které bude
pricteno k pozici kazdého bodu z mnoziny P, zavisi samoziejmé na hodnoté pa-
rametru [itter, ale také nepfimo na parametru Density. Pokud bude hustota bod
v roviné mala, bude celkové roztieseni vétsi nez v pfipadé, Ze pfi stejné hodnoté

12
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Obrazek 4.4: a) tapetovy vzor b) rozetovy vzor c) vlysovy vzor

parametru Jitter zvolime hustotu bod mnohem vétsi. Pfiklad trojihelnikové sité
z riznymi hodnotami téchto parametru Ize najit na obrdzku 4.5.

Téchto symetrii 1ze tedy vyuZit v oblasti ornamentalniho designu. Vytvofenim miizky
z Voronoiovych diagramt a naslednym obarvenim Voronoiovych polygonti vznikne za-
jimava mozaika. Voronoiovy polygony je mozné obarvit podle barvy generatoru ¢i zcela
ndhodné. Dalsi moznosti, jak je mozné tyto polygony obarvit, je pouzit barvy z podkla-

dového obrazku. Tento efekt, jenZ vytvoii mozaiku z obrazku je popsan v dalsi ¢asti 4.2
této kapitoly.

4.2 Efekt mozaikovdni pro vstupni obrazek

Jak uZz jsme si v pfedchozi ¢asti kapitoly naznacili, ¢tendf se zde mlize dozvédét, na
jakém principu je zaloZena tvorba mozaiek ze vstupniho obrazku. Zakladni idea tohoto
typu mozaiek, jak ji pouZiva editor Voronoiovych mozaiek, je zaloZena na vytvoreni
sité Voronoiova diagramu, ktery se jakoby pfilozi na vstupni obrézek. Néasledné dojde
k vybarveni v8ech Voronoiovych polygonti barvou pixelu, ktery je v obrazku umistén na
stejné pozici jako generator Voronoiova polygonu.

Vzhled takto vzniklé mozaiky je zavisly také na tvaru mfizky, ktera se na obrazek
priklada. Editor Voronoiovych mozaiek pracuje s tfemi typy miizek.

e Nahodné vytvorena sit’ generdtort tvoii jeden typ mifiZzek. V tomto piipadé se
nahodné vygeneruje urcity pocet generatort v roviné. Tento pocet je uréen parame-
trem Density. Parametr Jitter v tomto pfipadé nema smysl pouzivat, protoZe je zde
jiZ pfi vygenerovani pouZito urcité nahody.

e Symetricka miiZzka, jenZ vznikla z pouZzitim grup symetrii a jejiz popis ¢tenaf najde
v Casti 4.1, tvori druhy typ miiZzek. Nejcastéji pouzivany vzor pro mozaiky, které
vznikly z obrazku, je tapetovy vzor.

¢ Trojthelnikova sit"Voronoiova diagramu je tfetim typem miiZek, které jsem ve své
préci vytvorfila. Generatory byly uspotfadéany tak, aby vysledny Voronoitiv diagram
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Obrazek 4.5: Ptiklad sité Voronoiova algoritmu s riznou hodnotou parametru Density a
Jitter

tvofil trojahelnikovou sit. Vychézela jsem z bodu umisténého v levém hornim rohu,
tj. z pocate¢niho bodu celé sité. Obrazek 4.6 ukazuje postup generovani bodd do
sité. Posun ve sméru x—ové osy, zavisi na parametru Density. Cim vys$i tato hustota
je, tim mensi je posun generatoru ve sméru z. Postupné se tak stfida posun ve
sméru x—ové a y—ové osy. Posun ve sméru y—ové osy se sttidavé déje nahoru a
dolt. Jakmile se dojde na konec fddku a vygeneruje se jeho posledni bod, vratime
se opét na pozici prvniho bodu fadku a vygenerujeme prvni bod fddku druhého.
Proklad mezi témito dvéma fadky tvofi hodnota z, coZ je pfepona trojihelniku
tvofeného posunem x a posunem y. Ke generovani prvniho bodu fadku dochazi
stfidavé s hodnotou z a 2 * z. Postup je zndzornén na obrazku 4.6.

Hodnoty y a z je potfeba dopocitat z hodnoty z a také z hodnot tthlt trojihelniki.
JelikoZ cela sit’je tvofena rovnostrannymi trojihelniky, jejichz vnitini thly maji
kazdy 60°. Z tohoto mtZeme vyjadfit vztahy pro hodnoty y a 2.

x Y z

sin60°  sin30°  sin 90°

x sin 30°

X
- = = = —
sin60° 7 =5

x sin 90°

—_— =z = oz =
sin 60°

U trojuhelnikové sité miizeme opét pouzit vlastnosti parametri Jitter a Density,
pfiklad trojihelnikové sité s rliznymi hodnotami téchto parametrti mize ¢tenaf
vidét na obrazku 4.5.

14



4. NAVRH EDITORU
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Obrézek 4.6: Trojuhelnikova miizka

4.3 Vybarveni sité Voronoiova diagramu

V pfedchozich ¢astech této kapitoly jsme si popsali jakym zptisobem miize editor Voro-
noiovych mozaiek uspofadat generdtory v roviné a tim dosdhnout rtiznych efekta pfi
tvorbé mozaiek vzniklych z téchto diagram. S tvorbou sité VD je spojeno také vybarveni
Voronoiovych polygonti. Vybarvit tyto polygony Ize v editoru tfemi zptsoby. Tyto zpt-
soby, nebo-li médy, jsou zavislé na typu mozaiky, kterou si uZivatel pfeje vytvofit. Pro
kazdy generator mame k dispozici jeho soufadnice v roving, jeho aktualni barvu a také
index do pole ndhodnych barev.

e Mod vybarveni jednotlivych polygont podle vstupniho obrizku je zaloZen na
pfiloZeni mfizky na vstupni obrézek a nasledném vybarvenijednotlivych polygon.
U kazdého generatoru sité VD je nutné si zapamatovat pozici generdtoru v roving,
tj. jeho soufadnice. Pti pfilozeni m¥izky na vstupni obrazek se vybere barva pixelu
leziciho na x—ové a y—ové pozici kazdého generatoru.

e Mobd obarveni polygonu podle barvy generatoru vyuziva aktualni barvy genera-
toru. PouZziva se pfi vybarvovani sité, kterou vytvofil uzivatel s pouZzitim jedno-
tlivych grup symetrii. UZivatel si zvoli barvu generatort a pfi kliknuti do platna
editoru se vytvofi sit’ bodd. Barva, kterou si uzivatel pro jednotlivé generatory
vybral je barvou aktualni. Touto barvou se obarvi Voronoitv polygon a je mozné
takovym zptisobem vytvaret vicebarevné mozaiky.

15
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e Mod vybarveni polygonu ndhodnou barvou pouZziva ukazatel do pole nahodnych
barev. Po¢et ndhodnych barev v poli ur¢uje uzivatel. Kazdému polygonu je tedy né-
hodné pfifazena barva z tohoto pole. Editor také umoziiuje ndhodnym zptisobem
zménit barvu jiz obarvenych polygont v mozaice. Implementace tohoto obarvova-
ctho algoritmu je popsana v kapitole 5.

16



Kapitola 5

Implementace editoru Voronoiovych mozaiek

Editor Voronoiovych mozaiek byl vytvofeny kompletné v prosttedi Borland Delphi 6.
Pro vypocet Voronoiova diagramu jsem pouzila program Qhull [7]. Tento program byl
vytvofen na Minnesotské univerzité v Geometry Center. Je volné k dispozici pokud jsou
dodrzeny licenéni podminky. Soubor s licenci je obsaZen na pfilozeném CD. Spocita Vo-
ronoitv diagram na zékladé vstupnich tadaja, které tvori soubor s poctem Voronoiovych
generatort a jejich soufadnicemi. Jeho vystupem je opét soubor, tentokrat se soufadnicemi
Voronoiovych polygonti. Program nevykresluje Voronoiovy polygony, pouze spocita vr-
choly jejich soufadnic, coZ je jedna z mnoha funkci, ke které ho 1ze vyuzit. Mimo jiné je
mozné tento program vyuzit k vypoctu konvexnich obalii, Delaunayovy triangulace ¢i
k vypoctu Voronoiova diagramu tvofeného priéinikem polorovin.

Tato kapitola se zaméfuje na popis implementace jednotlivych prvkt editoru, p¥i éemz

vvvvvv

je kladen dtiraz na popis téch nejdtilezitéjsich ¢asti programu.

5.1 Popis pracovniho prostiedi

Prosttedi Borland Delphi umoZriuje pracovat s jiz pfedem pfipravenymi grafickymi kom-
ponentami a riznymi néstroji, coz usnadiiuje a urychluje tvorbu GUI. Takovymi prvky
jsou napiiklad tlacitka, zaskrtavaci boxy, policka textového vstupu, seznamy, zalozky a
dalsi. Zakladni prvky Delphi tvofi nasledujici ¢tyfi ¢asti:

¢ Object Inspector umoZnuje nastavit konkrétni vlastnosti jednotlivych komponent.
Lze zde nastavit napiiklad titulek komponenty, vertikalni a horizont4lni rozméry,
barva povrchu nebo pozadji, typ pisma pouZzitého uvnitf komponenty, fetézec, ktery
bude pouZit pro plovouci ndpovédu, viditelnost komponenty a dalsi.

e Object Treeview znazorfiuje stromovou hierarchii pouzitych komponent, coZ usna-
driuje préaci a pfistup k jednotlivym komponentam.

e Okno programu ukazuje vzhled vysledného editoru a tim umoziiuje vytvofit si
predstavu o vysledném vzhledu editoru. V tomto okné se vytvéii kone¢na podoba
programu. Na formula# programu se pfidavaji jednotlivé ovladaci prvky.

e Okno se zdrojovym kédem obsahuje zdrojovy k programu. V tomto okné se nasta-
vuje funkénost jednotlivym pfidanym komponentdm. Tyto komponenty je nutno
mezi sebou propojovat a vytvofit k nim zpétné vazby, tzn. akce, které se provedou
pfi vzniku urcité udalosti, napt. stisku tlacitka.
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TMainForm

TSymGenerator TDiagram

vvvvvv

vvvvvv

Mezinejdilezitéjsi objekty, které pouzivé editor Voronoiovych mozaiek pati TMai nFor m
TSymener at or a TDi agr am

TMai nFor mje hlavni formula¥, ktery reaguje na poZadavky uzivatele. Z Casti je vy-
tvofen prostiedim Delphi. A pokud do aplikace pfiddme né&jaky prvek, napf. tlacitko,
tak se automaticky prida do atributti TMai nFor m V tomto pfidédni nové komponenty do
svych atributti se li$ od objektt TSynGener at or a TDi agr am se kterymi spolupracuje.
Jejich spoluprace je zaloZena na tom, Ze hlavni formulaf vola tyto dva objekty a poza-
duje zpfistupnéni informaci. Pfikladem takto popsané spoluprace je vypocet diagramu
hlavniho formulafe. K tomu, aby mohl byt diagram spocitdn je potfebné znat pozice
jednotlivych generatort vytvofenych jednou z grup symetrii v plose. Pozice generatort
ziska hlavni formulaf od objektu TSymGener at or . Tento objekt dostane na vstup sou-
fadnice jednoho bodu a na vystup vrati pole soufadnic bod®i vygenerovanych urcitou
grupo symetrii. Tento objekt v sobé obsahuje definice vSech grup symetrii a podle typu
grupy symetrii a soufadnice prvniho bodu vygeneruje body dalsi. Poté dojde k zjisténi
jejich soufadnic, uspofddani do pole a piedani této informace hlavnimu formulafi.

Objekt TDi agr amje objekt, ktery slouZijako spravce diagramt. Pokud je ddn pozada-
vek od hlavniho formuléfe spocitat Voronoitiv diagram, tak tento objekt vytvofi soubor
s aktualnimi informacemi o diagramu (tj. aktudlnimi pozicemi vSech generatort) a preda
ho na vstup programu Qhull. Program spocitd, jak bude diagram vypadat a vrati objektu
TDi agr amopét soubor, ve kterém se nachazi informace o polygonech vysledného Voro-
noiova diagramu. Objekt TDi agr ammiuize v tomto okamziku opét pifedat pozadované
informace hlavnimu formulafi. Tento princip komunikace mezi tfemi vyse zminénymi
objekty ukazuje obrazek 5.1.

Jesté pred tim, neZ bude v dalsi ¢asti kapitoly vénovan prostor k popisu jednotlivych
objekttl, bych chtéla zminit, jakym zptisobem dochazi k pfepocétu souradnic, které pouziva
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Obrézek 5.2: Pfevod soufadnic z View do World

editor na soufadnice, které pouziva program Qhull pro vypocet samotného Voronoiova
diagramu. Tento pfevod ze soufadnic typu View do soufadnic svétovych, tzn. World,
pouZivaji objekty TMai nFor m TDi agr ami TSyntGener at or .

Soufadnice typu View jsou soufadnice, které pouziva editor Voronoiovych mozaiek
k vykresleni. Jsou to tedy pixelové soufadnice, které se udavaji v rozmezi0 az vyska a 0 aZ
sitka okna. Program Qhull vSak potiebuje k vypoctu Voronoiova diagramu pozici bodu
v readlnych soufadnicich, téZ oznacenych Svétové soufadnice, tj. soutadnice typu World.
Tyto svétové soufadnice jsou definovany pro hodnoty od —1-1 se sttedem v 0 a to pro
sitku i vysku. Procedura V2Wiesi tento pfevod. Je zde pouZito explicitniho vypoctu, ale
tento problém je mozné fesit i obecnéjsim pfistupem, ktery vyuziva linearni transformace.
Tento pfevod je pro vétsi ndzornost ukdzan na obrézku 5.2.

V dalsi ¢asti této kapitoly je vénovan prostor popisu jednotlivych objekti.

5.2.1 Hlavni formulaf

Objekt TMai nFor mse stara o vykresleni diagramu, komunikaci s uZivatelem, tzn. zpétnou
vazbu mezi pouzitymi komponentami a o vizudlni strdnku editoru. Sklada se z mnoha
atributd, z nichZ nékteré jsou vygenerované prostfedim Borland Delphi, proto si popiSeme

pouze nékteré nejdilezitéjsi atributy tohoto hlavniho formuléfe.
Privatnimi atributy hlavniho formuléfe jsou:

e ShowGener at or s je atribut typu Bool ean, ktery si uchovavéa informaci o tom,
zda se maji vykreslovat generatory na platno ¢i zda maji zlistat neviditelné. Tato
hodnota je na poc¢atku nastavenanat r ue.

e ShowEdges je atribut typu Bool ean, ktery jako v pfedchozim ptipadé si uchovéava
informaci o tom, zda maji byt vykreslené hrany polygonti. Poc¢ate¢ni hodnota je opét
nastavenanat r ue, takZe hrany Voronoiovych polygonti jsou zpocatku vykresleny.

e ShowPol ys podobné jako v pfedchozich dvou pfipadech se jedna o atribut typu
Bool ean, ktery nese informaci o vykreslovani polygond.
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Col or Mode je atribut vyctového typu (RandonC, PictureC, GeneratorC)
a urcuje, ktery vykreslovaci méd je pouzit pro vykresleni mozaiky. To znamena,
Ze se urci, jakym zptisobem se vybarvi polygony Voronoiova diagramu. Je mozné
polygony vybarvit zcela ndhodnym zptsobem v pfipadé typu RandontC, barvou
generatoru pokud je zvolen typ Gener at or Canebo barvou podkladového obrazku
jestlize byl zvolen typ Pi ct ureC.

RandontCol or s je atribut typu array of TCol or. Jedné se o pole ndhodnych
barev, ve kterém se uchovévajijednou vygenerované nahodné barvy, které se pouZiji
v piipadé kazdé akce pfi vykresleni, aby nedochazelo k neustalému generovani
barev novych.

Background je typu TBi t map, coz je atribut, ktery uchovava obrazek, jenZ se
vklada na pozadi.

Di agr am ktery je typu TDi agr ama slouZzi k vypoctu diagramu. Spolupracuje
s programem Qhull. Tento objekt bude popsan dale v této kapitole podrobnéji.

SynmGener at or je objekt typu TSymGener at or . SlouZi k praci s 36 grupami sy-
metrii. Bude popsan déle v této kapitole podrobnéji.

Program se skladd z mnoha procedur, které vytvéfeji zpétnou vazbu na néjakou

wev s

provedenou akci. PopiSeme si zde funkénost pouze nékterych nejdhlezitéjsich procedur.

For nCr eat e je konstruktor a plni tlohu pocate¢ni inicializace. Zpoc¢atku nastavi
na hodnotu t r ue atributy ShowGener at or s, ShowPol ys a ShowEdges. Vytvoii
instanci objektt TDi agr ama TSyn(Gener at or a pfifadi jim pocate¢ni nastaveni.
Nastavi také mnoho dal$ich parametrti, véetné obarvovacich médi.

For nDest r oyje destruktor, ktery na konci prace s programem smaZze vSechny
parametry nastavené pii inicializaci a ukoné&i praci s diagramem.

Di agr anGener at eExecut e je procedura, ktera je svazana s tlacitkem Generate
Points umisténym v editoru. Tato procedura zavola odpovidajici procedury, které

vytvoii sit’generatorti bud nahodné nebo tak, aby jejich diagram vytvofil trojahel-
nikovou sit. V pfipadé typu sité zaleZi na volbé, kterou uZivatel oznacil.

Di agr anConput eExecut e zavola odpovidajici metodu objektu TDi agr am pro
vypocet diagramu.

Vi ewCGener at or sExecut e, Vi ewedgesExecut e, Vi ewPol ygonsExecut e
zméni hodnotu typu Bool ean, tj. pfepind vykreslovani hran, generétorti a poly-
gonll a zavold vykreslovaci proceduru Dr awDi agr am ktera bude popsana dale
v textu.

Program je tvofen také skupinou procedur, které zméninastaveni vystupu diagramu
a zavolaji vykreslovaci proceduru. Téchto procedur je vétsi mnoZstvi, proto zde
uvadim pouze nékteré. Naptiklad:

20



5. IMPLEMENTACE EDITORU VORONOIOVYCH MOZAIEK

Edi t Densi t yChange je procedura, kterd zméni hustotu sité, tj. mnoZstvi
vygenerovanych bodt. Ovliviiuje generovani novych bod.

Edi t Ji tt er Change zméni roztfeseni bodt v ploSe. Ovliviiuje generovani
novych bodi.

TrackBar Ji tt er Change je procedura svazana s posuvnikem, ktery urcuje
miru roztfeseni pouZitého pfi generovani sité bodt.

TrackBar XOF f ser Change je opét procedura spojena s posuvnikem urcuji-
cim posun sité bod ve sméru x—ové osy

Di agr anCl ear Execut e vy¢isti platno editoru.

e Dalsi skupinou procedur jsou procedury, které zpracovavaji signaly z kliknuti a
pohybu mysi. Jsou to procedury:

- | mageMouseMove je procedura, kterd méni soufadnice pozice kurzoru mysi
na platné, tj. soufadnice typu View na soufadnice typu World a ty nasledné
zobrazuje ve stavovém fadku umisténém ve spodni ¢asti editoru pod platnem.
Timto je usnadnéna orientace na platné.

- | mmgeMouseDown zpracovava kliknuti mysi. V ptipadé, Ze bylo kliknuto le-

vym tla¢itkem mySi na platno editoru, pfevedou se x—ové a y—ové soufadnice
z typu View na typ World a daji se na vstup objektu TSynmCGener at or, ktery
podle uzivatelem zvolené grupy symetrii vrati vygenerované pole soufadnic
opét typu View. Nésledné dojde k volani vykreslené funkce a vykresleni vyge-
nerovanych bodt.
Pravé tla¢itko mysi slouzi k pfebarveni jednoho polygonu konkrétni barvou,
kterou si uzivatel pfed tim, neZ obarvi polygon vybral v dialogovém okné
barev. Pfi pravém kliknuti tla¢itka na plochu platna dojde opét k pfevodu
x—ové a y—ové soufadnice k pfevodu soufadnic z typu View do typu World.
Zjisti se vzdélenost tohoto bodu se vSemi dal$imi generétory diagramu a ten,
ktery je naSemu bodu nejbliZ se pfebarvi barvou uZivatelem vybranou. Dojde
k prekresleni diagramu.

e SpeedBut t onC i ck je procedura, ktera je volana pfi stisku kteréhokoliv tlacitka
oznacujiciho jednu z 36 grup symetrii. Tyto tlacitka se od sebe lisi tagem, tj. oznace-
nim. Podle této znacky se nastavi chovéani objektu TSynGener at or a pfed4 se mu
na vstup informace o pouZivané grupé symetrii.

e Jednu z dal$ich skupin procedur tvofi procedury, které pracuji se souborem. Patfi
mezi né napiiklad

— Procedura Fi | eSavePi ct ureAccept, kterd ukladad vytvofenou mozaiku
z platna ve formétu bmp a jpg.

- Fi | eSaveExecut e ulozi vSechna nastaveni diagramu, tj. hustotu sité, pou-
zivana hodnota roztieseni, Sifka a barva hran atd., véetné pozice a aktudlni
barvy generatort do souboru. Tim je umoZznéno pfi otevieni a naéteni souboru

pracovat se stejnymi hodnotami dale.
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- Fi | eOpenAccept slouzi k nacéteni informaci ze souboru a nastaveni para-
metrd na stejné hodnoty. Nacte také pozice generdtorti a zavold proceduru
k vykresleni diagramu.

e NewCanvas je procedura, kterd vytvoiri nové platno o rozmérech, které uzivatel
zadal do dialogového okna.

e Dtlezitou skupinkou procedur jsou procedury, které fesi rtizna barevna nastaveni.
Patfi mezi né nasledujici procedury:

- TrackBar RandonChange méni pocet nahodnych barev pouZitych pfi vybar-
veni polygont ndhodnym zptisobem. Je zde implementovano pole ndhodnych
barev o velikosti tohoto po¢tu nahodnych barev, ktery si uzivatel voli posuvni-
kem. Je mozné zvolit hodnotu v rozmezi 1 az 10. Kazdy generator si uchovéava
informaci o své pozici, aktudlni barvé a také ukazatel do tohoto pole ndhod-
nych barev. Pfi kazdé zméné poctu pouzitych ndhodnych barev se zavola tato
procedura, vytvoii se pole nahodnych barev a generatortim se pfifadi novy
index do tohoto pole. Poté dojde k vykresleni diagramu.

- Act i onRandontCol or NewExecut e je spojena s tla¢itkem New Colors a naplni
polozky v poli ndhodnych barev ndhodné zvolenou barvou.

- Di agr anChangeCol or sExecut e umoziiuje zménit barvy polygoni. Pou-
ziva ndhodnych barev, ale zachovéava stejnou barevnost polygont s identickou
barvou. Nejdfive se zjisti pocet pouzitych barev v mozaice. Tzn. projdou se
vSechny generatory a postupné se ukladaji jejich barvy do pole dvojic.To zna-
mend, Ze kazda nové pouzitd barva, kterd neni v poli jeSté obsaZena se zatadi
na konec tohoto pole a vygeneruje se k ni barva ndhodnd. Tak vznikne pole
dvojic, které pro kazdou pouzitou barvu mozaiky uchovavé barvu ndhodnou.
Ve druhém prtichodu pfifadim vzdy generatortim, které mély stejnou barvu
novou barvu z pole dvojic.

e DrawDi agr amje privatni procedurou, ktera slouzi k vykresleni diagramu a je vo-
lana mnoha jinymi procedurami. Po svém zavolani dojde k vycisténi platna.
Pokud je pfepinac¢ pro vykreslovani hran polygonu (tj. ShowEdges) nastaven na
hodnotut r ue, nastavi se kreslici pero tak, jenz mé barvu takovou, jakou si uzivatel
zvolil v barevném dialogovém okné a vykresli hrany polygoni.

Jestlize je hodnota atributu ShowPol ys nastavena na hodnotut r ue, tak se nastavi
vykreslovaci $tétec a jeho barva se nastavi podle zvoleného vykreslovactho médu.
Pokud je zvolen vykreslovaci méd ndhodny, tak generator u sebe nese index do pole
nahodnych barev, tj. zvoli se tato nahodné barva. Pokud je zvolen méd obarveni
podle obréazku, tak se zjisti barva pixelu v obrazku nachazejici se na stejné pozici
jako generétor a pokud je zvolen vykreslovaci méd podle generétoru, zvoli se ak-
tudlni barva generatoru a pfifadi se do Stétce. Takto se vybarvi polygony.

Nakonec se v pfipadé, Ze je hodnota atributu ShowGener at or s nastavenanat r ue
vykresli generatory.

22



5. IMPLEMENTACE EDITORU VORONOIOVYCH MOZAIEK

5.2.2 Vypocet soufadnic generator z grup symetrii

Objekt TSynGener at or spolupracuje s hlavnim formulafem, ktery mu pfedava na vstup
soufadnice jednoho bodu a ¢islo konkrétni grupy symetrif a tento objekt vraci pole sou-
fadnic bodt vygenerovanych touto konkrétni grupou symetrii. K definici jednotlivych
grup symetrii pro tapetové, pasové a rozetové vzory objektu TSynGener at or jsem
vyuzila ¢ast programu Java Kali[8], ktery je volné k dispozici. Jsou zde definovany trans-
formace pro kazdou z grup symetrii zvlast. Zdrojovy kéd jsem piepsala z prosttedi Java
do Borland Delphi.

Objekt TSymGener at or vyuziva k vypoctu soufadnic generétorti také pomocné da-
tové typy a konstanty. Jsou zde definovany konstanty, které se vyuZzivaji p¥ijednotlivych
transformacich provadénych v grupach symetrii, nap¥. v/2 je konstanta, ktera se pouziva
pfi rotaci generatorti. Praci s grupami symetrii také usnadruji tfi nasledujici pomocné
datové typy typur ecord.

e Typ TDVect or definuje vektor, jenZ se pouZziva pii transformacich s grupami sy-
metrii.

e Typ TDMat r i x definuje matici, kterd se rovnéz vyuziva p¥i précis grupami symetrii.

e Typ TSymmet r yG oup je reprezentaci jedné konkrétni grupy symetrii, v niz se na-
chézi definice typu reflexe, klouzavé reflexe, fddu rotace, poc¢tu translaci a konkrétni
translace.

Atributy objektu TSynGener at or , které objekt vyuZziva pfi préci s grupami symetrii
jsou:

e Current G oup urcuje ¢&islo aktualni grupy symetrii. Grupy symetrii jsou ocislo-
vany od 0-35, pfi ¢emZ grup tapetového vzoru je 17 (tzn. hodnoty 0-16), pasovy
vzor je definovan 7 grupami symetrii (tzn. hodnoty 17-23) a rozetovy vzor urcuje
12 grup (hodnoty 24-35).

e Density je hodnota typu I nt eger, kterd udava hustotu sité generatorti. Tato
hodnota je pfeddna hlavnim formuldfem TMai nFor ma ovliviiuje velikost vektoru,
jenz se pouZzivéa pii transformacich v grupach symetrii.

e Jitter je stejné jako pfedchozi hodnota pfedavan hlavnim formuldfem a urcuje
jakd mira ndhody je pouZita pfi generovéani bodi. Po uréeni kone¢né pozice bodu
se k tomuto bodu pficte urcity Sum, jehoz velikost je zavisla na tomto parametru.

e G oups je typu array of TSymmetryG oup, coZ je pole vSech grup symetrii
definovanych v objektu TSynmGener at or . Pfi inicializaci dojde k naplnéni tohoto
pole jednotlivymi grupami symetrii, respektive jejich konkrétnimi parametry.

e Rotati onMatri X je pomocna matice, kterd slouzi pfi vypoctech rotaci.

e TNPAr r ay je pomocné pole, ve kterém se uchovévaji soufadnicejiz vygenerovanych
bodt. Toto pole se (po vygenerovani vSech bodt a ulozeni jejich soufadnic do
tohoto pole) predava jako vystup objektu TSyntener at or hlavnimu formulafi,
ktery potom tento vysledek zpracovava dale.
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Procedury objektu TSynmGener at or jsou nésledujici:

e Konstruktor Cr eat e je zodpovédny za pocatecni inicializaci tohoto objektu. Zpo-

¢atku si vytvofi matice rotaci a pfedpocita vsechny rotace pro kazdy typ této trans-
formace.
V dalsi fazi postupné vklada do pole Gr oups jednotlivé grupy symetrii spole¢né
s jejich parametry. O toto postupné vkladani grup do pole se stard funkce SGLoad,
ktera podle aktudlniho ¢isla grupy symetrii vlozi do pole informace o ni. Takto
budou do pole nacteny vSechny grupy symetrii.

e Procedura MakePoi nt s je volana z hlavniho formuléfe. Dostane na vstup sou-
fadnice jednoho bodu a vréti pole obsahujici soufadnice bodi vygenerovanych
dle aktudlniho ¢&isla grupy, kterou si uZzivatel zvolil pro svou praci. Implemen-
tace této procedury je zaloZena na celé skupiné metod, kterd se postupné aplikuje
na pocéatecni bod. Sklada se ze ¢tyt fazi, které odpovidaji provadéni nésledujicich
transformaci: reflexe, klouzava reflexe, rotace a translace.

— V prvni fazi je na vstupni bod aplikovana procedura Dr awPoi nt R G Rt Tr,
tzn. nejprve se aplikuje transformace reflexe, jejiz druh je zavisly na ¢isle grupy
symetrii. Pfi reflexi mohou vzniknout nové body. Tyto body se véetné bodu
pocéte¢niho zpracovévaji ve f4zi druhé.

— V druhé fazi se tedy na vSechny body aplikuje procedura Dr awPoi nt G Rt Tr,
ktera provede klouzavou reflexi zavislou na konkrétni grupé symetrii. Opét
se vSechny nové vniklé body vcéetné bodt plivodnich predaji na vstup tteti
procedufe.

- V tfeti fazi se na vSechny body opét aplikuje procedura Dr awPoi nt Rt Tr,
ktera provede rotaci vSech bodti podle aktudlni grupy symetrii. VSechny body
se opét piedaji na vstup posledni z této skupiny procedur.

— V posledni ¢tvrté fazi se na body aplikuje procedura Dr awPoi nt Tr, ktera
aplikuje translaci na vSechny body. Translace je zde definovédna zvlast’ pro
jednotlivé typy vzorti. P¥i rozetovém vzoru se translace neprovadi, na body se
v posledni fazi aplikuji pouze atributy Densi ty a Ji t t er . Pfi pdsovém vzoru
se translace provadi pouze v pasu jednim transla¢nim vektorem. A nakonec
pfi tapetovém vzoru se body generuji po celé plose pomoci dvou transla¢nich

vektorti. Vysledné soufadnice bodti se zapisi do pole TnpAr r ay a to se pfeda
hlavnimu formulafi.

e Dalsi procedury jsou pouze pomocné procedury. Patfi sem jiZ vySe zmiriovana
procedura SGLoad a dalsi pro operaci s vektory.
5.2.3 Vypocet Voronoiova diagramu

Objekt TDi agr amspolupracuje s hlavnim formuldfem a také s programem Qhull, ktery se
stard o vypocet Voronoiova diagramu. Uchovavé také soufadnice generatorti a vrcholt
polygont VD. Spolupréce s hlavnim formuldfem spociva ve vypoctu VD na zédkladé
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soufadnic bodd, které objekt TDi agr amobdrzi od hlavniho formuléfe. Tento objekt také
slouzi ke generovani sité bodti ndhodnym zptisobem a do trojihelnikové sité.

TDi agr ampouzivé k vypoctu VD nékolik pomocnych datovych typti. Tyto datové
typy tvofi nasledujici:

Typ TPoi nt Wje typu record a udava redlné souradnice typu World. Slouzi ke
komunikaci s programem Qhull, ktery pracuje s redAlnymi soufadnicemi v rozmezi
od-1do 1.

Typ TPoi nt Vje opét typur ecor d a urcuje celociselné soufadnice typu View. Kromé
téchto soufadnic uchovava také informace o aktudlni barvé generédtoru a index do
pole ndhodnych barev, jehoz velikost je zavisla na po¢tu nahodnych barev, které se
pouziji pfi ndhodném vybarveni polygonti, a které si uZivatel zvoli na posuvniku
v editoru Voronoiovych mozaiek.

Typ TPol ysl je typu array of array of |nteger. Je to typ pole polygon,
jenZjsou zadané indexy do pole Ver t i cesV, coZ je pole, které uchovéava soufadnice
vrcholti Voronoiova polygonu.

Typ TPol ysVije typuarray of array of TPointV, tzn. jedna se typ pole po-
lygonti, jenz jsou zadény soutadnicemi typu View.

Atributy objektu TDi agr am které objekt pouZiva jsou néasleduyjici:

I mageW dt h, | mageHei ght jsou atributy typu | nt eger , které uchovavaji infor-
mace o rozmérech platna, jenz jsou potfebné k pfevodu soufadnic z typu View do
World a naopak.

Densi ty, Jitter jsoucelo¢iselné atributy, které udavaji hodnotu hustoty a roztre-
seni, pouzitych pfi generovani bodt do trojihelnikové sité ¢i ndhodnym zptisobem.

QVPat h uchovava cestu k programu QVor onoi . exe.

Dalsimi atributy je skupina atribut, které uchovavaji informace o VD.

Soufadnice generatorti se uchovéavaji v reprezentaci View a World soucasné. K jejich
uchovani slouzi atributy Gener at or sWa Gener at or sV.

Programu Qhull jsou na vstup pfeddny soufadnice bodt typu World. Vystup pro-
gramu Qhull tvofi soutadnice vrchol jednotlivych polygont VD. Tyto soufadnice
se ukladaji v poli Ver ti cesW uchovévaji se také v reprezentaci View a to v poli
VerticesV.

K uchovéni polygont slouzi atributy Pol ysV a Pol ysl, které uchovavaji sou-
fadnice vrchol@i polygonti indexem a také v konkrétnich hodnotach. Toto dvoji
uchovévani soufadnic slouZi k rychlejsimu vypoctu programu.

Procedury objektu TDi agr amjsou nasleduyjici:

e Konstruktor Cr eat e plni funkci inicializace celého objektu.

e Cl ear VP smaZe polygony a vrcholy a tim vy¢isti platno editoru.
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MakeRandonGener at or s je procedura, kterd generuje sit’bodt ndhodnym zpt-
sobem. Na vstup dostane barvu, kterou budou vSechny generatory vytvofeny a
tim nasledné vybarveny vSechny polygony a také velikost pole ndhodnych barev.
Vytvoifi nahodné body rozlozené po celém platné. Pocet takto vytvofenych bodt
je omezen parametrem Densi t y. Zaroven s generovanim bodt vytvaii pro kazdy
bod index do pole ndhodnych barev.

Procedura MakeTr i angl eGener at or s generuje sit’bodti do trojahelnikové miiz-
ky postupem popsanym v 4.2. Hustota a pravidelnost této sité je ovlivnéna parame-
try Densi ty a Ji tter. Na vstup opét jako v pfedchozim pi¥ipadé dostane barvu
generatorti a velikost pole ndhodnych barev. Pfi vygenerovani bodu do trojihelni-
kové sité zaroven vytvofi pro kazdy generator index do pole nahodnych barev.

MakeBoundi ngGener at or s vytvofi takzvané hrani¢ni generatory, coZ jsou 4 ge-
neratory vytvofené mimo platno editoru, které slouzi k tomu, aby hrany diagramu
neutikaly do nekonecna.

Conput eDi agr amje procedura, ktera preda soufadnice generatorti v reprezentaci
World programu Qhull. Pfesnéji fe¢eno, zapiSe tyto soufadnice do souboru, ktery
preda programu na vypocet Voronoiova diagramu. Program Qhull vrati opét sou-
bor, v némz jsou uloZené soufadnice vrcholli polygonti a samotné polygony, které
se zde nachézi ve formé indexti na polygony.
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Kapitola 6

Popis a ovladani editoru Voronoiovych mozaiek

Tato kapitola se vénuje popisu prostiedi, prace a ovladani editoru Voronoiovych mozaiek.
Ctenat se zde dozvi jak je vytvoreno uZivatelské prostiedi a jakym zptisobem je mozné
s programem pracovat. Editor se sklada ze spustitelného souboru Voronoi.exe a také je
potiebné ve stejném adresafi mit program QVoronoi.exe, coz je ¢ast programu Qhull a
zpracovava vstup a vystup, je ovladan prepinacem, jenZ ovliviiuje béh a vystup programu.
Dalsi ¢ast editoru tvoii soubory Voronoi.hlp a Voronoi.cnt, které vytvareji ndpovédu k préci
s editorem.

6.1 Popis uzivatelského prostiedi

Po otevieni souboru Voronoi.exe se spusti editor Voronoiovych mozaiek, jehoz pracovni
prostiedi je zndzornéno na obrazku 6.1.

Toto pracovni prostiedi miizeme rozdélit do tfech zakladnich ¢asti. V horni ¢asti edi-
toru se nachéazi hlavni menu, které umoZznuje uzivateli pracovat se zdkladnimi funkcemi
editoru. Pod nim lze nalézt nastrojovou listu, ktera obsahuje nejcastéji pouzivané funkce
v editoru, takZe uzivatel ma& moZnost pracovat s touto liStou, aniz by musel listovat
v hlavnim menu. Stfed editoru vypliiuje pracovni platno, jenZ méa nastavitelnou sitku a
délku. Pokud uzivatel vytvafi mozaiku z vlastniho obrazku, platno se pfizptisobi veli-
kosti tohoto obrazku. JestliZe je naopak vytvafena mozaika, ktera pouZziva grup symetrif,
je mozné si nastavit velikost platna, na kterém se bude pracovat. Pfi pohybu mysi po
platng, se v dolni ¢ésti editoru zvané stavovy pruh objevuji x—ové a y—ové soufadnice
kurzoru mysi. DileZitou roli pfi kreativni tvorbé v editoru hraji také tfi zalozky, které se
nachézi v pravé ¢asti editoru. Je mozné se mezi nimi libovolné pfepinat a volit si tu ze
zaloZek, kterd je zrovna potfebna k praci v editoru. Jednotlivé polozky v editoru jsou pfi-
stupné pies klavesové zkratky al t +podt r zené pi smeno.Nasledujici ¢ast této kapitoly
je vénovana stru¢nému popisu jednotlivych ¢asti editoru.

6.2 Menu

e Polozka Soubor (File) se pouZiva pro zakladni prace s editorem a k ukonceni
programu.

- Novy (New) — Otevieni a nastaveni velikosti nového platna pro kresleni mo-
zaiek.

— Otevi¥it (Open) — Nacteni souboru, ktery byl v minulosti uloZen.
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oronoi Diagram Edito =](3

File Colors Diagram View Help

D Open Background... Generate points &Qompule Diagram Toggle Edges D Clear Generators

4| Parameters I Pattems | Colors etc. |

Generator type
" Random
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Obrazek 6.1: Editor Voronoiovych mozaiek

Ulozit (Save) — ZapiSe pozici a aktudlni barvu jednotlivych generédtord do

souboru a tim umozni pfisté oteviit soubor s mozaikou a pokracovat v jeji
tvorbé.

Ulozit jako (Save as) — UloZzi soubor pod ur¢itym jménem.

Konec (Exit) — Ukon¢i préci s editorem.

Oteviit pozadi (Open Background) — Otevie vstupni obrazek a pfizptisobi
platno jeho velikosti.

- Ulozit obrazek (Save Picture) — UloZi uZivatelem vytvofenou mozaiku jako
obrazek ve formatu bmp, jpg,....
e Piikaz Barvy (Colors) slouzi k barevnym nastavenim a zméndm v mozaice.
— Vyber barvu generitori (Select Generator Colors) — Vyvola dialogové okno
pro zadani barvy generétorf.

— Vyber barvu hran (Select Edge Colors) — Vyvola dialogové okno pro zadani
barvy hran Voronoiova polygonu.

— Zmén barvy (Change Colors) - Zméni obarveni mozaiky. Polygony s identic-
kou barvou budou pfebarveny ndhodné vybranou barvou. Vzhled mozaiky
zustane zachovan.
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41 Voronoi Diagram Editor.
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Obrézek 6.2: Menu editoru

e Polozka Diagram se vénuje vytvofeni a iipravam Voronoiova diagramu na platné
editoru.

- Vygeneruj body (Generate Points) — Vytvoii sit’ Voronoiova diagramu bud’
nadhodné nebo do trojihelnikové sité, podle toho, jaké parametry zvolil uZivatel
na zalozce Parametry (Parameters).

- Spocitej diagram (Compute Diagram) — Vypocita Voronoitiv diagram z vy-
tvorené sité generatora.

- Vy¢isti generatory (Clear Generators) — Vycisti platno.

e Ptikaz Zobrazit (View) umoZniuje ménit nastaveni zobrazeni jednotlivych ¢asti Vo-
ronoiova diagramu.

— Vypni/Zapni zobrazeni generatorti (Toggle Generators) — umoZriuje zapnout
a vypnout viditelnost generatorti v mozaice. .

— Vypni / Zapni zobrazeni hran (Toggle Edges) — Zapina a vypind viditelnost
hran polygonti ve VD.

— Vypni / Zapni zobrazeni polygonti (Toggle Polygons) — Pfepina viditelnost
barevné vyplné polygonti, takze umoziiuje v piipadé, Ze je barevna vypln
vypnuta, vidét, jak miiZzka p¥iléha na vstupni obrazek.

e Polozka Napovéda (Help) podé uZivateli napovédu, jak pracovat s editorem. Ob-
sahuje také konkrétni pfiklady a ukédzky obrazka pro jednotlivé pfipady tvorby
mozaiky. V ndpovéde je mozné se orientovat pomoci obsahu a vyhleddvani v ném.

6.3 Nastrojova lista

Néstrojova liSta (toolbar) obsahuje zadkladni pfikazy, které se pfi tvorbé mozaiky pouZivaji.
Usnadriuje praci uzivateli tim, ze polozky této nastrojové listy jsou umistény vedle sebe
na ploSe a uZivatel nemusi listovat v menu. Néstrojova liSta obsahuje nasledujici polozky,
jejichZ funkce je vysvétlena v ¢asti popisu menu.
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D Open Backaround... :'] Generate points 1\'; Compute Diaaram Toaale Edages |:] Clear Generators

Obrazek 6.3: Nastrojové lista

Oteviit pozadi (Open Background)

Vygeneruj body (Generate Points)

Spocitej diagram (Compute Diagram)

Vypni/Zapni zobrazeni hran (Toggle Edges)

Vy¢isti generatory (Clear Generators)

6.4 Zalozky

Zalozky tvori dtlezitou ¢ast editoru. Umoziiuji komunikovat s uzivatelem a vytvéfet
tak postupné mozaiky. Lze je roz¢lenit na tfi ¢asti. Prvni zdlozka se vénuje parametrtim
generatori pfi vytvareni sité VD, v druhé zaloZce najde uzivatel tlacitka pro tvorbu
mozaiek s vyuZitim grup symetrii a ve tfeti zaloZce je moZné nastavit parametry, jenz
ovliviiuji vzhled mozaiky. Obréazek 6.4 ukazuje vSechny tfi zdlozky editoru Voronoiovych
mozaiek.

6.4.1 Zalozka Parametry (Parameters)

Zalozka Parametry se vénuje nastaveni hodnot pottebnych pro vypocet sité VD.

e Polozka Typ generatoru (Generator type) urcuje, jakym zptisobem se vygeneruje
sit'VD.
— Nahodny (Random) — Generétory se budou generovat nahodnym zptisobem.
- Trojtahelnik (Triangle) — Generédtory budou vytvéret trojahelnikovou sit’.

e Polozka Parametry generator (Generator Parameters) urcuje konkrétni vlastnosti
generator(i v roviné.

— Hustota (Density) — Urcuje jakou hustotu bude mit sit’ VD. Je moZné volit
hodnotu v rozmezi 1-100.

- Roztfeseni (Jitter) — Urcuje jaké bude celkové roztfeseni sité bodi, jaka bude
pouzita nahoda pfi jejich generovani. PouZiti této polozky mé smysl pouze
v pfipadé trojihelnikové sité a pfi pouZiti grup symetrii. Je mozné volit ho-
dnotu v rozmezi 0-100.

— Posun po x-ové ose (X-Offset) — Posuvnik, ktery urcuje o kolik se posune
miizka ve sméru x—ové osy.
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Obrazek 6.4: Zalozky: Parametry, Vzory, Barvy atd.

— Posun po y-ové ose (Y-Offset) — Posuvnik, ktery urcuje o kolik se posune
miiZka ve sméru y—ové osy.

e Polozka Obarvovaci méd polygont (Polygon coloring mode) urc¢uje jakym zptiso-
bem se vybarvi polygony v mozaice.

— Generitor (Generator) — Barva pro vypli polygonti je uréena barvou genera-
toru, kterou zvolil uzivatel.
— Nédhodny (Random) — Barva polygonu je zvolena ndhodné.

— Obrazek (Picture) — Vybarveni polygonti podle vstupniho obrazku. Barva
polygonu je zavisla na barvé pixelu, ktery se nachazi na stejné pozici v obrazku
jako generator Voronoiova polygonu.

6.4.2 Zalozka Vzory (Patterns)

Zalozka Vzory slouZi uZivateli k vytvareni mozaiek s vyuZitim grup symetrii. UZivatel si

zvolijednu z grup symetrii a kliknutim na platno vytvafi mozaiky. Tato zalozka obsahuje
celkem 36 grup symetrii, rozdélenych do tech vzord.
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e Tapetovy vzor (Wallpapers) — Obsahuje celkem 17 grup symetrii.
e Vlysovy vzor (Frieze) — Obsahuje celkem 7 grup symetrii.

e Rozetovy vzor (Rosette) — Obsahuje celkem 12 grup symetrii.

6.4.3 Zilozka Barvy atd. (Colors etc.)

Tato zélozka je vénovana nastaveni parametrti dilezitych pro vzhled mozaiky. To zna-
mend barevna nastaveni generétord, hran, ale také tloustku hran.

e Polozka Ndhodné barvy (Random Colors) obsahuje posuvnik s hodnotami 1-10,
ktery je implicitné nastaven na hodnotu 4. Zde si uZivatel nastavi kolik ndahodnych
barev se ma pfi vybarveni polygont nastavit. Tla¢itko Nové barvy (New Colors)
pfifadi mozaice tolik nahodnych barev, kolik jich uZivatel na posuvniku nastavil.

e Tlacitko Zmén barvy (Change Colors) zméni barvy v mozaice, takovym zptiso-
bem, Ze polygony vybarvené identickou barvou budou piebarvené jinou ndhodné
vybranou barvou, tak Ze pocet barev v mozaice se nezméni.

e Posuvnik Tloustka hrany (Edge Thickness), ktery méa hodnoty 1-10 s implicitné
nastavenou hodnotou 1, urcuje tloustku hran Voronoiova polygonu.

e PoloZka Vlastnosti barev (Color Parameters) obsahuje dvé barevné okna s oznace-
nim Barva hran (Edge Color) a Barva generdtortt (Generator Color). Pfi kliknuti
na kazdé z téchto oken se objevi dialog pro zadavani obarveni hran a generatort.
Zde si uZzivatel voli, jakou barvou budou vybarveny polygony a jejich hrany.
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Kapitola 7

Prace s editorem

V této kapitole se budu snazit naznacit zptisob prace s programem. Budou zde ukézany
zékladni postupy, jak ziskat pozadovany vystup ve formeé obrazku ¢i souboru. Kapitola je
doprovazena kratkymi ukazkami téchto postupti. Obséhlejsi vystupy jsou prezentovany
v pfiloze této diplomové prace. A konkrétni nastaveni vSech jednotlivych parametrii
je k dispozici v napovédg, jenz je soucasti programu. Zde najde uzivatel jejich popis a
také detailni ukazky. Tato kapitola si klade za cil vysvétlit princip préce s editorem, za
predpokladu, Ze ¢tenaf je obeznamen s funkci programu popsanou v pfedchozi kapitole
6.

7.1 Tvorba mozaiky vytvorené ze vstupniho obrazku

Cely postup bude prezentovan na obrazku 7.1 a). Obsahuje pouze dvé barvy a hrany, takze
pIné postaci pro nas tcel pfedvedeni jednotlivych funkci programu. Pro tvorbu mozaiky
z uzivatelem zadaného obrazku je potfeba mit obrazek v jednom z téchto formatt: jpg,
bmp, ico, wmf, emf. Obrazek se nacte na pozadi piikazem File > Open Background. Je mozné
také pouzit klavesovou zkratku Ct r | +B. Timto se otevie obrazek, se kterym budeme
dale pracovat. V zaloZce Parameters se automaticky nastavi zptisob obarvovani na volbu
Picture. Velikost platna se nastavi na velikost obrazku. Dalsi krok je zavisly na typu

miizky, kterou si uZivatel pfeje vytvorit. Miizka miize byt vygenerovdna automaticky
nebo vytvofena ru¢né uZzivatelem.

e Automatické vytvofeni sité bodu
Pfi této volbé se uZivatel rozhodne, zda si pfeje vygenerovat body ndhodné v plose
¢i do trojuhelnikové sité.

— V zaloZce Parameters si uzivatel vybere typ generatorti a oznaci pfislusnou
polozku, tzn. oznac¢i bud’ volbu Random (v p¥ipadé nahodné rozmisténych
bodti) nebo oznaci volbu Triangle, pokud maji byt generdtory umistény do
trojihelnikové miizky.

— V zéloZce Generator Parameters je potfeba nastavit hustotu sité generatort. Tento
parametr se nastavi v posuvniku s oznacenim Density, kde hodnota 1 znaci
nejmensi hustotu generatorti a hodnota 100 hustotu nejvétsi. V posuvniku Jit-
ter se zvoli, zda chceme, aby pfi tvorbé Voronoiovych generétort byla pouZita
nepravidelnost. Tato volba ma smysl pouze tehdy, pokud generujeme sit’ troj-
thelnikd a umoznuje zavést do jejich tvorby mirnou az velkou nepravidelnost
a tim ovlivnit celkovy vzhled mozaiky. Pokud si uzivatel pfeje posunout sit’
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Obrazek 7.1: a) Vstupni obrazek b) Vygenerované body c) Sit"VD

generatort po x-ové &i y—ové ose, pouzije posuvniky s oznacenim X-Offset a
Y-Offset.

- V dalsim kroku se vypocita sit’generatorti dle uzivatelova nastaveni. P¥tikazem
Diagram > Generate Points, se vytvoii sit'Voronoiovych generatort. Tuto situaci
ilustruje obrazek 7.1 b). Generatory zde byly vytvofeny ndhodné, hustota sité

je nastavena na hodnotu 40.

- Ptikazem Diagram > Compute Diagram vznikne mozaika tvofena Voronoiovym
diagramem. Pfiklad ndhodné vygenerované sité na obrazku 7.1 c), pfiklad
trojihelnikové sité je na obrazku 7.2 c).

e Uzivatelem vytvofena sit’generatora
Pokud si uZzivatel pfeje vytvofit sit’ generdtord sim, umoznuje mu to zalozka Pat-
terns. Zde jsou k dispozici tfi paletky s pfednastavenymi grupami symetrii, které
urcuji, jakym zptisobem se budou body generovat. Tyto jednotlivé vzory byly po-
psany v kapitole 6.2.

V paletce Wallpapers je mozné vybirat ze 17 grup symetrii. Tyto grupy symetrii
pokryvaji plochu platna rovnomérné po celé jeho Sifce a vySce, zplisobem, ktery
odpovida urcité, uzivatelem zvolené grupé symetrii.

V paletce Frieze je moZné vybirat ze 7 grup symetrii. Pfi této volbé se budou gene-
ratory vytvaret pouze v pasu umisténého uprostied obrazovky. Tato volba nema
u mozaiek tvofenych ze vstupnich obrazk pf#ili§ velké uplatnéni.

V paletce Rosette je moZzné vybirat ze 12 grup symetrii, které vytvareji sit’ genera-
torti do kulatého tvaru, nepokryvaji (stejné jako v p¥ipadé volby Frieze)celé platno
rovnomeérné, proto jejich pouZiti mé spiSe vyznam pro mozaiky vytvafené rucné,
ne ze vstupniho obrazku.

- V zéloZce Generator Parameters je potfeba v posuvniku Density nastavit hustotu
sité generatorti a v posuvniku Jitter se zvoli, zda chceme, aby pfi tvorbé Voro-
noiovych generatorti byla pouZita nepravidelnost. V pfipadé, Ze by méla byt
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Obrazek 7.2: a) Vstupni obrazek se siti bodi b) Mozaika c) Trojahelnikova sit" VD

sit’bodi posunuta v horizontalnim ¢i vertikalnim sméru, zvoli se tato moZnost
v posuvnicich X-Offset a Y-Offset.

— V zalozce Colors etc. je k dispozici polozka Color Parameters, ve které se nachazi
okno Edge Color. Zde si uZzivatel zvoli barvu hran sité VD. A v posuvniku Edge
Thickness si nastavi tloustku hran Voronoiovych polygonti.

— Po téchto zakladnich nastavenich si uzivatel v zaloZzce Patterns zvoli jednu
z grup symetrii. Kliknutim na platno, na kterém je na podkladé umistén vstupni
obrazek, se vygeneruji body. Na obrazku 7.2 a) je pfiklad vstupniho obrazku,
na ktery byla umisténa sit’ tvofena jednou z grup symetrii tapetového vzoru.

- Ptikazem Diagram > Compute Diagram vznikne mozaika tvoifena Voronoiovym
diagramem. Pfiklad mozaiky tvofené vstupnim obrazkem a uZivatelem vytvo-
fené miizky demonstruje obrazek 7.2 b).

Editor Voronoiovych mozaiek umoziiuje zménit barevné nastaveni a tloustku hran,
i kdyZ mozaika byla jiz vytvofena. Pro tuto zménu se opét v zéloZce Colors etc. > Color
Parameters > Edge Color vybere nova barva a hrany se automaticky pfebarvi. V posuvniku
Edge Thickness je moZzné dodatecné zménit silu hran. Zména se opét projevi automaticky.
Pfiklad mozaiek vzniklych ze vstupniho obrdzku z rtzné nastavenymi parametry je
k dispozici v pfiloze této diplomové prace.

V piipadg, Ze uzivatel neni s vysledkem své prace spokojeny, mtize piikazem Diagram
> Clear Generators sit’ generatori smazat a zacit s praci znovu. V opac¢ném piipadé je
mozné uloZit rozmisténi bodt v plose do souboru pfikazem File > Save. UloZi se pozice
vSech generatorti a pfi otevieni souboru pfikazem File > Open se sit’bodti opét umisti do
plochy do stejné pozice. Tato volba je vhodné v pfipadé, Ze si uZivatel pfeje pracovat a
vylepSovat sit’po delsi dobé. Jestlize povaZuje uZivatel praci na mozaice za ukoncenou,
uloZi obréazek pifikazem File > Save Picture. Obrazek lze ulozit ve formatech jpg, bmp.
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Obrazek 7.3: a) Sit’ VD tvofend vicebarevnymi body v tapetovém vzoru b) Mozaika
vznikl4 z této sité c) Body v rozetovém vzoru d) Mozaika typu rozeta

7.2 Tvorba mozaiky z vlastnich m¥iZek

Voronoi Editor umozZiuje uzivateli vytvofit mozaiku, kterd vznikne vygenerovanim siti
Voronoiovych generator(i uzivatelem. Princip je zaloZeny na generovani rtiznobarevnych
bodti na plose dle ur¢itych pravidel a naslednému spocitani Voronoiova diagramu. UZi-
vatel mtiZze vyuZzivat mnoha parametr(i v nastaveni Voronoi editoru a tim aktivné ménit
vzhled samotné mozaiky.

Postup pfi tvorbé mozaiky tohoto typu se sklada z nasledujicich kroki:

e Tvorba m¥iZzek

— Pfi praci s vlastnimi mfizkami si uZivatel na zacatku nejdfive nastavi velikost
platna, na kterém bude pracovat. Toto nastaveni je mozné provést ptikazem
File > New, pfi jehoZ vyvolani se objevi dialogové okno, do kterého uZivatel
zad4 rozméry plétna, na kterém bude pracovat.

— V zéloZce Patterns si uzivatel vybere jednu z grup symetrii, kterou bude pou-
Zivat.

— V zaloZce Generator Parameters je potfeba nastavit hustotu a roztfeseni sité ge-
neratort. Tyto parametry se opét nastavi v posuvnicich Density a Jitter. Pokud
si uzivatel pfeje posunout sit’generatort po x-ové a y-ové ose, pouZije posuv-
niky s oznacenim X-Offset a Y-Offset. Posunuti ve sméru téchto os se vyuzije
zejména pfi tvorbé pasového ¢i rozetového vzoru. Napiiklad pii generovani
rozety se muZe stat, Ze uzivatel neklikne pfesné do stfedu a kousek mozaiky
je tak schovan pod hranici viditelnosti a timto posunem je mozné mozaiku
zviditelnit celou.

- V zéloZce Generator Parameters se automaticky nastavi obarvovaci méd na po-
loZzku Generator, coZ znamend, Ze Voronoiovy polygony se budou vybarvovat
barvou generatoru.
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— V zaloZce Colors etc. je k dispozici polozka Color Parameters, ve které si uzivatel
zvoli barvu generatorti, podle nichZ se potom vybarvi Voronoiovy polygony.
V této poloZce si také vybere barvu hran polygont. Po kliknuti na okna Edge
Color a Generator Color se objevi barevna dialogova paleta, ze které je mozné
zvolit pozadovanou barvu.

- Po téchto zdkladnich nastavenich uzivatel kliknutim na platno vytvofi urcity
vzor. V tomto okamZiku je moZzné opét zvolitnovou barvu generatorti v polozce
Colors etc. > Generator Color. V okamzZiku dalsiho kliknuti na platno se vytvori
nova skupinka barevnych bodt. Takto je mozné postupovat dle uvazeni jesté
nékolikrat. Priklad takto vytvofené sité VD ukazuje obrazek 7.3. V pfipadé a)
lze vidét body usporadané do tapetového vzoru a z nich vzniklou mozaiku,
v pfipadé c) je ukazka sité bodt usporadanych do rozetového vzoru.

- Ptikazem Diagram > Compute Diagram vznikne vysledna mozaika.

Pokud si uzivatel pfeje vypnout zobrazeni generétor, hran ¢i polygont Voronoiova
diagramu, zvoli ptikaz View > Toggle Generators (> Toggle Edges)(> Toggle Polygons)
stejnymi p¥ikazy je mozné zobrazit generatory, hrany a polygony zpét. Pfi otevieni
souboru piikazem File > Open se sit’'bodt opét umisti do plochy do stejné pozice.
Vysledny obréazek je mozné ulozit ve forméatech jpg, bmp a to piikazem File > Save
Picture.

7.3 Zména obarveni mozaiky

V piipadé, Ze si uzivatel vytvofil zajimavou mozaiku, ma k dispozici mfizku generatort,
ale neni spokojeny s barvami, které pro svoji mozaiku pouzil, je i pfesto mozné toto
obarveni Voronoiovych polygonti zménit. V podstaté 1ze vyuZzit dvou pfebarvovacich
principti ke zméné barev v mozaice. Barvy lze nahradit zcela nahodnym zptisobem nebo
zachovat polygony, které jsou identicky obarvené a jen zménit jejich barvu.
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Obréazek 7.5: Mozaika tapetového vzoru, kterd byla dvakrat pfebarvena zptisobem za-
chovéavajicim pocet barev.

e Nahodné obarveni polygont

- Pfinahodném obarveni polygonti se v zéloZce Parameters automaticky nastavi
obarvovaci méd na polozku Random.

- Uzivatel bude pracovat se zalozkou Colors etc., ve které je k dispozici polozka
Random Colors. V posuvniku v ni umisténém si zvoli kolik ndhodnych barev
by mélo byt pfi pfebarveni mozaiky pouzito a zméackne tlacitko New Colors.

- Po kazdém zméacknuti tlacitka se vygeneruje urcity pocet ndhodnych barev
nastavenych v posuvniku. Pfiklad mozaiky, ktera byla obarvena ndhodnym
zptsobem rtiznymi pocty barev Ize vidét na obrazku 7.4 c) a d). V ptipadé c)
byly pouZity dvé ndhodné barvy a v piipadé d) bylo pouZito deset barev.

e Zména obarveni mozaiky se zachovinim po¢tu barev

V zéloZce Parameters se v tomto piipadé obarvovaci méd nastavi na hodnotu Gene-
rator. Polygony, které maji identickou barvu zméni barvu generéatoru (ta bude opét
u téchto polygonti stejnd) se pfebarvi novou ndhodné vybranou barvou. Tato zména
se provede u vsech polygonti v mozaice. V zaloZce Colors etc. je umisténo tlac¢itko
Change Colors. Po jeho stisknuti se provede pozadovana zména pfebarveni se za-
chovanim poctu barev v mozaice. Postup je opét mozné opakovat az dosdhneme
libivého obarveni mozaiky. Tento pfipad pfebarveni mozaiky demonstruje obrazek
7.5.

e Zména barvy jen urcitého poctu polygoni
Pokud byla vytvofena mozaika a uZivatel je spokojeny s tvarem miizky i s celkovym
obarvenim a poZaduje zménu barvy pouze jednoho nebo urcitého poctu polygont
v mozaice, pfichdzi i tato moZnost v tivahu.
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Uzivatel bude pracovat se zédlozkou Colors. etc. V polozce Color Parameters se otevie
paletka pro obarvovani generatort (kliknutim na volbu Generator Color). UzZivatel
si vybere vhodnou barvu a pravym tla¢itkem mysi klikne do oblasti polygonu,
ktery chce piebarvit. Zméni se tak barva polygonu a je mozné zvolit dal$i barvu a
tim obarvit dalsi polygon ¢i polygony. Pfiklad uvadi obrazek 7.4. V ptipadé a) je
mozaika ptivodni, v ptipadé b) byly polygony dodate¢né obarveny vyse popsanym
zplisobem.
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Kapitola 8
Zavér

Hlavnim tkolem mé diplomové préce bylo vytvofit programové dilo, které by dokéazalo
tvofit mozaiky zaloZené na Voronoiovych diagramech. Mély by to byt mozaiky, které
vzniknou z uZivatelem zadaného obrazku, ale také mozaiky, které uzivatel vytvoiri sam.
Vysledkem by mél byt vystupni obrdzek ve vhodném formatu, ktery je mozné déle pouzit
¢i dale upravovat v jinych grafickych editorech.

Snazila jsem se vyuzit také algoritmt a programfi, které byly jiz vytvofeny a na-
programovény, a tim urychlit béh programu a také vse skloubit a vytvofit tak funkcni
program pro tvorbu mozaiek. Pouziti programu Qhull mi usnadnilo préci pfi vypoctech
Voronoiovych diagrami.

Pfi prvnim ndvrhu samotného editoru jsem zamyslela vytvofit pouze algoritmus
pracujici se vstupnim obrazkem. Ale pfi postupném seznamovani se s touto tématikou
jsem nasla mnoho jinych zajimavych problémf, které by staly za to, abych se nimi ve své
diplomové préci déle zabyvala. Velmi mne nadchla myslenka vytvofit si vlastni mfizky,
které se dale prilozi na vstupni obrazek a vysledek ma potom urcitou pravidelnost.
Zacala jsem se tedy zabyvat napadem umistit Voronoiovy generéatory v roviné takovym
zplisobem, aby vysledek tvofil symetrickou mfizku. K tomuto jsem vyuZila vlastnosti
grup symetrii. JenZe s timto napadem byl spojen ihned napad dalsi, a to rozsitit samotny
editor o tvorbu mozaiek tapetového, pasového a rozetového typu, které budou tvofeny
Voronoiovym diagramem a nebudou zavislé na vstupnim obrazku, ale predpokladaji
spolupréci s uZivatelem. Takto vznikl navrh editoru popsaného v této praci.

Urcity ¢as jsem se také zabyvala volbou vhodného programovactho prostredi. Pi-
vodné jsem program zacala pséat v programovacim jazyce C++ a prostfedi KDE. Uvédo-
mila jsem si vSak, Ze takto napsany editor by nemusel byt snadno pfistupny ve vyuce,
proto jsem radéji zvolila prostfedi Borland - Delphi 6. Editor vytvofeny v tomto prostiedi
je snadno spustitelny na vSech pocitacich v uc¢ebné pro vyuku vytvarné informatiky.

S programem se podle mého nézoru pracuje dobfe, protoZe jeho rychlost je velika.
Préci s editorem usnadriuje program Qhull, ktery byl pro vypocet Voronoiovych diagramt
pouZit. TakZe béhem nékolika sekund lze vytvofit mozaiky zaloZené na Voronoiovych
diagramech. Také uZivatelské prostfedi jsem se snaZila navrhnout tak, aby bylo na prvni
pohled intuitivni. Editor se skldda z nékolika komponent, jenZ jsou vénované vzdy urcité
oblasti prace s editorem.

Nejvétsim problémem, se kterym jsem se pfi tvorbé editoru setkala, byla definice
transformaci jednotlivych grup symetrii. Tyto definice jsem pievzala z volné dostupného
programu Java Kali a pfepsala z programovaciho jazyka Java do prosttedi Borland Delphi.

V textu této diplomové prace jsem se snaZila popsat vyvoj takového editoru. Od teorie,
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8. ZAVER

pres popis ndvrhu az po implementaci a prezentaci vysledkii mého programu. Zaméfila
jsem se zejména na popis a funkénost samotného programu.

Snahou mé préce bylo tedy vytvorit editor, ktery by se dal vyuzit v oblasti vytvarné
informatiky. Existuje mnoho dal$ich napadd, které by bylo mozné zaclenit do funkci
editoru Voronoiovych mozaiek a tim jeho funkénost rozsitit. To by vsak musela soucast
dalsi diplomové préce, protoZe jiz tak jsou funkce mého programu velmi obsahlé. Velmi
mé zaujala myslenka tvofit fraktaly s vyuZitim Voronoiovych diagramf, ktera je popsana
v [5]. MoZna by tato idea mohla byt ndmétem dalsi diplomové prace.
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Obrézek A .4: Tapeta ¢.4
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Obréazek A.5: Rozeta vybarvend nékolika zptisoby
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Obréazek A.7: Rozeta ¢.2
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Obréazek A.8: Pdsova mozaika ¢.1

Obréazek A.9: Pdsova mozaika &.2
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Obréazek A.12: Mozaika ze vstupniho obrazku z mfizky pomoci grup symetrii,se zobra-
zenim hran
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Obrazek A.13: Mozaika ze vstupniho obrazku zndhodn
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Obrazek A.16: Mozaika ze vstupniho obrazku z m#izky pomoci grup symetrii, bez zob-
razeni hran
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